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Preface 
This guide clearly and concisely sets out the information developers need to know to get started with 
the CASIO IT-600 development. Every method of connecting to your development system is 
covered and step by step instructions for installing and testing the CASIO SDKs are included. 
 
The purpose of this guide is to get you to the point where you can start development; you should 
refer to the library manuals for detailed information on the specific APIs. 
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1. Product Overview 

1.1 Hardware Specifications 
The IT-600 series handheld terminal is one of the most powerful and versatile handheld devices on 
the market. It is particularly suited to the retail, stocktaking, parking enforcement and hospitality 
markets. 
 
Table 1.1  Hardware specifications 

Item Specification Remark 
CPU, Memory 

CPU Marvell® PXA270 Application Processor Operating clock; max 520 
MHz 

RAM 64 MB   

FROM 128 MB (user area; approx. 60 MB)  
Scanner 

Type Semi-conductor laser light  
Wave Length 650±10 nm  
Optical Output <1 mW  
No. of scannings 100±20 times per second  
Resolution 0.127 mm (minimum)  
PCS 0.45 (minimum)  

Approx. 400 mm Without HA-D50BN 
attached 

Readable distance 

Approx. 0 to 200 mm With HA-D50BN attached 
Max. 48 mm When the distance is at 40 

mm. 
Max. 314 mm When the distance is at 400 

mm. 

Readable width 

Max. 60 mm (contact scanning) When HA-D50BN is 
attached. 

Daylight for scanning 50,000 Lux or less  

 

Readable 1D bar code 
symbologies 

UPC-A, UPC-E, EAN, Codabar, Code39, 
ITF, MSI, Industrial 2of5, Code93, Code128, 
IATA, EAN128, RSS-14, RSS Limited, RSS 
Expanded 

 

Vibrator Yes (for indications of scanning completion, 
VoIp call-in) 

 

Display 
Display device 3.7-inch transflective TFT color LCD 65,536 colors (See note 3) 
No. of dots 480 (h) x 640 (w)  
Dot pitch 0.117 (h) x 0.117 (w) mm  
Gradation 65,536 colors  
Display font Scalable font  

  

Backlight LED  
Indicator 

 LED 1pc x LED (2 colors), 1pc x LED (3 colors) Left: battery charge status 
Right: programmable 

Input 
Keyboard Numeric (Alphabet) keys, CLR key, Execute 

key, Fn key, Text key, Cursor key 
 

Control keys Power ON/OFF key, Reset switch  
Trigger keys Trigger R key, Trigger L key, Center Trigger 

key 
  

Touch panel Yes  
Continue. 
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Infrared communication interface  

Standard IrDA ver.1.3 compatible  
Communication 
process 

Half duplex  

Synchronization Start-stop, frame method  
Baud rate (in bps) 9600, 19200, 38400, 57600, 115200, 4M  

 

Communication 
range 

0 (contact) to 0.3m   

WLAN 
Standard IEEE 802.11b/g compatible  
Modulation  DS:          IEEE802.11b 

DS/OFDM:   IEEE802.11g 
 
See note 1. 

Frequency range IEEE802.11b: 2.400 to 2.4835 GHz 
IEEE802.11g: 2.400 to 2.4835 GHz 

 

Baud rate IEEE802.11b: 11 Mbps (maximum) 
IEEE802.11g: 54 Mbps (maximum) 

 

Communication 
range 

IEEE802.11b/g: 50 m (indoor) to 150 m 
(outdoor) 

Vary depending on the 
environment 

Number of channels 13 Three channels are 
available at the same time.

Output power IEEE802.11b: 12 to 15 dBm 
IEEE802.11g: 12 to 14 dBm 

 

 

Other feature Roaming between Access-Points  
Bluetooth 

Standard Bluetooth® Specification Ver.1.2 Not operable concurrently 
with WLAN operation. 

Comm. range Approx. 3 m Vary depending on the 
environment 

 

Output power Max. 3 dBm ( PowerClass 2)  
USB 

Full speed (12 Mbps)  Baud rate 
Low speed (1.5 Mbps)  

Host 

Power to an 
external 
device 

5V±5% (maximum 500 mA) See IT-600 Series 
Hardware Manual. 

 

Client Baud rate Full speed (12 Mbps)  
Extension port Connector for HA-D94CFU or for HA-D51TG Not applicable to 

IT-600M30R, M30CR. 
M30R2, M30CR2, 
M30R2-CN, M30CR2-CN

SD card slot miniSD memory card In the battery 
compartment. 

 
         

Layout 
    

1 2 3 4 5 6 7 8  

Terminals 
for USB 
cradle 

Description See IT-600 Hardware Manual. 

 

Headset jack 4 poles in rounded shape  
Speaker Monaural  
Microphone Monaural See note 2. 
Digital camera 

Number of pixels Approximately 1,000,000 pixels  
Device 1/4.5-type CCD color  
Aperture F3.5/F7.0 (2 steps switchover)  
Focal distance f = 3.29 mm (fixed)  

 

Image capture range 30 cm to ∞  
LED light 
 Brightness 3300 mcd  

Continue. 
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Power 
Operation Lithium-ion battery pack (HA-D20BAT or 

HA-D21LBAT)  
 

Memory backup Lithium battery (rechargeable) on board  
Battery capacity HA-D20BAT   1,850 mAH 

HA-D21LBAT  3,700 mAH 
 

IT-600M30, M30C, 
M30-CN, M30C-CN, 
M30E2, M30E2-CN, 
M30C2, M30C2-CN 

IT-600M30R, 
M30CR, 
M30R-CN, 
M30CR-CN, 
M30R2,  
M30R2-CN, 
M30CR2, 
M30CR2-CN 

 Operating period 

Approx. 11 hours 
(with 
HA-D20BAT)*1 
Approx. 22 hours 
(with 
HA-D21LBAT)*1  
 

Approx. 10 hours 
(with 
HA-D20BAT)*2 
Approx. 20 hours 
(with 
HA-D21LBAT)*2 
 

*1 based on the ratio of 
“standby:calculation:scan” at 
20:1:1 when the CPU speed is 
set to auto power save mode 
and the backlight is turned off. 
*2 based on the ratio of 
“standby:scan:calculation:wirel
ess” at 20:1:1:1 when the CPU 
speed is set to auto power save 
mode and the backlight is 
turned off. 

Memory backup 
period 
(with Lithium 
battery only) 

RAM : Approx. 10 minutes 
Clock : Approx. 72 hours or longer 

- Lithium battery is fully 
charged. 

- At room temperature. 

Memory backup 
period 
(with Lithium 
battery and 
Lithium-ion battery 
pack) 

RAM : Approx. 72 hours with HA-D20BAT
RAM : Approx. 72 hours with 
HA-D21LBAT 

- After “VDET1” warning 
message is issued. 

Lithium-ion battery 
pack charge period 

Approx. 4 hours for HA-D20BAT 
Approx. 7 hours for HA-D21LBAT 

- The power on the terminal is 
turned off. 

- At room temperature 
- The dedicated AC adaptor is 

used to power the terminal 
via battery charger or cradle.

Memory backup 
battery charge 
period 

Approx. 4 days - Time period until when the 
memory backup battery is 
fully charged. 

- Lithium-ion battery pack is 
being installed. 

- At room temperature. 
Memory backup 
battery rated 
capacity 

10 mAh  

Power supply by 
cradle 

Yes 

By battery pack 
(when terminal’s 
power on ) 

Yes 

 

Method to charge 
memory backup 
battery 

By battery pack 
(when terminal’s 
power off) 

Yes 
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Notes: 
1. Orthogonal frequency-division multiplexing (OFDM) is a transmission technique based upon 

the idea of frequency-division multiplexing (FDM). 
2. The microphone is not integrated in IT-600M30R2-CN and IT-600M30CR2-CN to comply 

with the Chinese radio related regulations. Both the models disable the capability of voice data 
transmission over Internet Protocol (VOIP). 

3. Dead Pixels 
The LCD panel employed in this product uses high precision and substantial number of 
components which commonly cause a small number of the pixels not to light or to remain lit all 
the time. This is due to the characteristics of LCD panel yield in accuracy over 99.99% and 
permissible. 

http://en.wikipedia.org/wiki/Frequency-division_multiplexing�
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1.2 Library Configuration 
The CASIO Software Development Kit (“SDK”) for IT-600 series provides various libraries listed 
in the table. 
 
Table 1.2 

Library Description C++ VB
C# 

System Library Library that is used to control the system. Yes Yes
Laser Scanner Library Library that is used to control the built-in laser scan engine. Yes Yes
Bluetooth Library Library that is used to control the built-in Bluetooth module. Yes Yes
Camera Library Library that is used to control the built-in Camera module. Yes Yes
Imager Library Library that is used to control the built-in CMOS imager. Yes Yes
JPEG Library Library that is used to handle and manipulate JPEG image 

functions. 
Yes - 

FLINK Library Library that is used to control and carry out 
transmission/reception of files between PC and other device. 

Yes Yes

Note: 
The abbreviations used in the table are; 

C++ : Visual C++ 
VB : Visual Basic .NET 
C# : Visual C# .NET 

 
The names of the Dynamic Link Libraries for C++ and C#/VB for the device oriented libraries are 
listed in the table. 
 
Table 1.3 

Library Dynamic Link Library Dynamic Link Library 
(Class Library) 

System Library SystemLib.dll SystemLibNet.dll 
Laser Scanner Library OBReadLib.dll OBReadLibNet.dll 
Bluetooth Library BluetoothLib.dll BluetoothLibNet.dll 
Camera Library CameraLib.dll CameraLibNet.dll 
Imager Library ImagerLib.dll ImagerLibNet.dll 
JPEG Library JpegCe.dll None 
FLINK Library FlinkLib.dll MoFlinkLib.dll 
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1.3 Development Reference Manuals 
The CASIO Software Development Kit (“SDK”) for IT-600 series includes the development 
reference manuals listed in the table. 
 
Table 1.4 

Development Manual Description 
Quick Start Guide This reference manual. 
Hardware Manual Reference manual that describes hardware specifications in detail on each 

dedicated option and IT-300 handheld printer terminal 
Software Manual Reference manual that describes software specifications in detail for all the 

software integrated in IT-600 handheld printer terminal. 
System Library Manual Reference manual that describes individual functions in detail for System 

Library. 
Laser Scanner Library Manual Reference manual that describes individual functions in detail for Laser 

Scanner Library. 
Bluetooth Library Manual Reference manual that describes individual functions in detail for Bluetooth 

Library. 
Camera Library Manual Reference manual that describes individual functions in detail for Camera 

Library. 
Imager Library Manual Reference manual that describes individual functions in detail for Imager 

Library. 
JPEG Library Manual Reference manual that describes individual functions in detail for JPEG 

Library. 
FLINK Library Manual Reference manual that describes individual functions in detail for FLINK 

Library. 
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1.4 Sample Program 
The following sample programs are included in the IT-600 SDK. 
 
Table 1.5 

Sample Program Description 
Common Device Control 

BLUETOOTHLIBSAMPLE Connects the terminal to a Bluetooth printer and prints out data. 
CAMERALIBSAMPLE Takes pictures and displays them on the screen. 
IMGLIBSAMPLE Scans bar codes using the Imager with settings set with Imager setting 

file. 
IMGLIBSAMPLE2 Program of IMGDemo.exe 
OBRLIBSAMPLE Reads a bar code using the Laser library. 
PRNLIBSAMPLE Prints out data on the built-in printer. 

 

SYSTEMLIBSAMPLE Demonstrates LED and buzzer functions. 
JPEG Library 
 JPEGSAMPLE Displays Jpeg files. 
FLINK Library 
 FLINKLIBSAMPLE Demonstrate infrared communication via FLINK protocol between two 

terminals. 
Note: 
Some of the sample programs such as IMGLIBSAMPLE, IMGLIBSAMPLE2, and 
PRNLIBSAMPLE in the table do not run because the respective devices are not integrated in the 
IT-600. 
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2. Prerequisites 

2.1 Skills Required 
The following skills are required by developers aiming to develop application software for the 
IT-600: 
• Windows programming 
• A good knowledge of one or more of the following: 

- Visual C++ 
- Visual Basic .NET 
- Visual C# 
- Active Server Pages and web programming (not covered in detail in this guide) 

 
The following skills or experiences are also desirable: 
• Windows CE devices 
• ActiveSync 
• Some networking experience 
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2.2 Hardware Required 
The following models of the IT-600 series and the dedicated options are available. 
• IT-600 
Table 2.1  Available models and the features 

Wireless Communication Model no. Laser 
scanner Bluetooth IEEE802.11b/g

Digital 
Camera Remark 

IT-600M30 * Yes Yes No No 
IT-600M30C * Yes Yes No Yes 
IT-600M30R * Yes Yes Yes No 
IT-600M30CR * Yes Yes Yes Yes 

See note 1. 

IT-600M30E2  Yes Yes No No  
IT-600M30C2 Yes Yes No Yes  
IT-600M30R2 Yes Yes Yes No  
IT-600M30CR2 Yes Yes Yes Yes  
IT-600M30E2-CN Yes Yes No No 
IT-600M30C2-CN Yes Yes No Yes 
IT-600M30R2-CN Yes Yes Yes No 
IT-600M30CR2-CN Yes Yes Yes Yes 

See note 2. 

Notes: 
1. The model with “*” will phase out as soon as its stock runs out, and be replaced by its 

successor model with “2” at the end of the model number. 
2. “-CN” in the “Model” boxes denotes that the model is dedicated for China only. 
 
• Dedicated Options 

- HA-D20BAT (Battery Pack) 
- HA-D21LBAT (Large-capacity Battery Pack) 
- AD-S15050BE (AC Adaptor for HA-D30CHG Cradle-type Battery Charger) 
- AD-S42120B (AC Adaptor for HA-D60IO USB Cradle and HA-D62IO Ethernet Cradle) 
- AD-S60160BE (AC Adaptor for HA-D36DCHG Cradle-type Dual Battery Charger) 
- DT-380USB (USB cable) 
- HA-D50BN (Laser Redirection Attachment) 
- HA-D60IO (USB Cradle) 
- HA-D62IO (Ethernet Cradle) 
- HA-D30CHG (Cradle-type Battery Charger) 
- HA-D32DCHG (Dual Battery Charger) 
- HA-D36DCHG (Cradle-type Dual Battery Charger) 
- HA-D51TG (Trigger Grip) 
- AC-CORD-EU (Power cord for AD-S42120B/Europe) 
- AC-CORD-US (Power cord for AD-S42120B/USA and Canada) 
- AC-CORD-TW (Power cord for AD-S42120B/Taiwan) 
- AC-CORD-KR (Power cord for AD-S42120B/Korea) 
- AC-CORD-AU (Power cord for AD-S42120B/Australia) 

 
See the following page for each external view of the IT-600 and the dedicated options. 
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External views of the IT-600 and the options 

 
Figure 2.1 

USB Cradle / Ethernet Cradle 

HA-D60IO 
HA-D62IO 
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2.3 Software Required 
PC Operating System 
• Microsoft Windows 2000 Professional Service Pack 4 or later 
• Or Microsoft Windows 2000 Server Service Pack 4 or later 
• Or Microsoft Windows XP Professional Service Pack 2 or later 
• Or Microsoft Windows 2003 Server Service Pack 1 or later 
• Or Microsoft Windows Vista (Business / Ultimate ) 
• Or Microsoft Windows 7 
• Or Microsoft Windows Server 2008 

 
The following software tools and libraries are required in order to develop software for the IT-600. 
Ensure that you download or purchase the correct Microsoft tools as appropriate. 
 
C / C++ 
• Microsoft Visual Studio 2008 (not free of charge) 
• Microsoft Visual Studio 2005 (not free of charge) 
• Microsoft eMbedded Visual C++ 4.0 

Download for free from; 
http://www.Microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=1DACDB3D-
50D1-41B2-A107-FA75AE960856 

• Microsoft eMbedded Visual C++ 4.0 SP4 
Download for free from; 

http://www.microsoft.com/downloads/details.aspx?familyid=4A4ED1F4-91D3-4DBE-986E-
A812984318E5&displaylang=en 

• Microsoft ActiveSync 4.2 (or later) 
Download for free from; 

http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d
3233efb4c&DisplayLang=en 

• Microsoft Windows Mobile Device Center 6.1 (for Windows Vista) 
Download for free from; 

http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-0
9F07AAA1914&displaylang=en 

 
Visual Basic / Visual C# 
• Microsoft Visual Studio 2008 (not free of charge) 
• Microsoft Visual Studio 2005 (not free of charge) 
• Microsoft Visual Studio .NET 2003 (not free of charge) 
• Windows CE Utilities for Visual Studio .NET 2003 Add-on Pack 1.1 

From Microsoft web site, see 
http://www.microsoft.com/downloads/details.aspx?familyid=7ec99ca6-2095-4086-b0cc-7c6c
39b28762&displaylang=en 

• Microsoft ActiveSync 4.2 (or later) 
Download for free from; 

http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d
3233efb4c&DisplayLang=en 

• Microsoft Windows Mobile Device Center 6.1 (for Windows Vista) 
Download for free from; 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=1DACDB3D-50D1-41B2-A107-FA75AE960856�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=1DACDB3D-50D1-41B2-A107-FA75AE960856�
http://www.microsoft.com/downloads/details.aspx?familyid=4A4ED1F4-91D3-4DBE-986E-A812984318E5&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=4A4ED1F4-91D3-4DBE-986E-A812984318E5&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=7ec99ca6-2095-4086-b0cc-7c6c39b28762&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=7ec99ca6-2095-4086-b0cc-7c6c39b28762&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
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http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�
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3. Installing SDK to PC 

3.1 Application Development 
This chapter explains about what you need to set up for the development environment before 
starting your application development. 
 
1. Installing Development Platform 

Install Microsoft’s development platform which supports eMbedded Visual C++, Visual Studio 
2005 and Visual Studio .NET 2003. For detail, refer to Chapter 2.3 “Software Required”. 
 

2. Installing CASIO SDK 
Install CASIO SDK and various libraries if necessary. For installation method, refer to Chapter 
6.1 “Installing CASIO SDK Files”. 
 

3.  Connecting IT-600 to PC (via ActiveSync/Windows Mobile Device Center) 
Connect the IT-600 to PC via Microsoft’s ActiveSync (for Windows XP or any other OS 
before Windows XP) or via Windows Mobile Device Center (for Windows Vista or later). For 
connection method, refer to Chapter 5 “Connecting the IT-600 to PC”. 
 

4. Setting Up the Development Environment 
Copy all necessary CASIO libraries to the IT-600. 
For detail, refer to Chapter 6 “Setting Up the Development Environment”. 
 

5. Installing the Device Emulator 
Install the Device Emulator for the IT-600. For installation method, refer to Chapter 7 “Device 
Emulator”. If not necessary to install, go to the next step “6. Application Development” below. 
 

6. Application Development 
Now, the application development environment is set up and your development with the 
development platform can be started. After application is developed, transfer it to the Device 
Emulator or an actual terminal of the IT-600 via ActiveSync or Windows Mobile Device 
Center for check on the operability. For application development method and transferring your 
application, refer to Chapters 8 “eMbedded Visual C++” and 9 “Visual Studio”. 
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3.2 Installing CASIO SDK Files 
Download the CASIO IT-600 SDK installation CD image file from the following site and write it to 
a CD-ROM media. 
http://www2.casio.co.jp/system_en/pa/PADealer/  
(The site requires your user name and password. Enter your user name and password as issued by 
CASIO.) 
 
Notes: 
• If you had already installed IT-600 SDK Ver. 1.xx, be sure to uninstall it before installing Ver. 

2.xx. 
• If any file of the IT-600 SDK Ver. 1.xx is remained in the following folders after uninstalling, 

delete it manually. 
C:\Program Files\CASIO\MBSYS 
C:\Program Files\Windows CE Tools\wce500 

• If your PC runs in the Windows Vista or later OS, first you must disable the User Account 
Control (“UAC”) by following the process below before installing the CASIO SDK Files. 

 
  Case of using Windows Vista and Windows Server 2008 

- Navigate to Control Panel → User Accounts → Enable or Disable the User 
Account Control. Remove the check on User Account Control (UAC) to protect 
your PC, and then click OK button. 

 
  Case of using Windows 7 

- Navigate to Control Panel → User Accounts → Change User Account Control 
Settings.  Select Never notify in Choose when to be notified about changed to your 
computer setting. 

http://www2.casio.co.jp/system_en/pa/PADealer/�
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Installing ExportSDK 
1. When the CASIO IT-600 SDK CD-ROM is inserted in the drive of your PC, the following 

menu screen appears automatically. 

 
Figure 3.1 

 
2. Click Installation List in Figure 3.1. The installation screen appears. 

 
Figure 3.2 

 
3. Click IT-600 ExportSDK to display the Setup Wizard. Choose any one of the buttons in the 

screen. 
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Installing Library 
The IT-3100 Library is available for the below development platforms. The library can be installed 
for each development platform in the Installation List screen. 
 

- Microsoft eMbedded Visual C++ 4.0 
- Microsoft Visual Studio .NET 2003 
- Microsoft Visual Studio 2005 
- Microsoft Visual Studio 2008 

 
Notes: 
1. The Library header file (*.h) and the Import library file (*.lib) are installed in the following 

folder. 
C:\Program Files\CASIO\MBSYS\include : Header file 
C:\Program Files\CASIO\MBSYS\lib\ARMV4I : Import library file 

2. The Class library DLL file (*.dll) is installed in the following folder. 
C:\Program Files\CASIO\MBSYS\WindowsCE 

3. When the Library is installed in PC, the Help file (*.chm) is installed in the following folder. 
C:\Program Files\CASIO\MBSYS\HELP 
 

The Help file can be accessed by navigating to Start menu → All Programs → CASIO Basic 
Development Kit → Help. 

 
 

Installing Online Help 
Besides the Help file described above, the Online Help is also available for the below development 
platforms. The installation of the Online Help is initiated in the Installation List for each 
development platform. 
 

- Microsoft Visual Studio .NET 2003 
- Microsoft Visual Studio 2005 
- Microsoft Visual Studio 2008 

 
After the installation is complete, Microsoft Visual Studio starts up. The Online Help file can be 
accessed by navigating to Help → Contents menu. 
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Installing Sample Program 
When the Sample is chosen in the Installation List, the sample program folder in the CD-ROM 
appears. The Sample program folder is available for each development platform. Copy one of the 
folders you wish to use into your PC. 
 
- EVC for Microsoft embedded Visual C++ 
- VS2003 for Microsoft Visual Studio.NET 2003 
- VS2005 for Microsoft Visual Studio 2005 
- VS2008 for Microsoft Visual Studio 2008 
 
If your sample program is with "Read-only" attribute set effect. Be sure to disable the attribute 
before using it. 
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4. Connecting Power Supply to HA-D60IO, HA-D62IO 

4.1 HA-D60IO 
Use the dedicated AC adaptor (AD-S42120B) for power supply to the HA-D60IO USB cradle. 
Make sure to connect the AC adaptor to the USB cradle before starting communication between the 
IT-600 and PC via the cradle. Follow the steps below to set power supply to the IT-600 using the 
dedicated AC adaptor. 
 
1. Plug the AC adaptor into the AC adaptor jack where “DCIN12V” is printed by on the back of 

the cradle. See Figure 4.1. 

 
Figure 4.1 

 
2. After connecting the power cable to the AC adaptor, plug in the plug to an electrical outlet. 
3. Make sure the selector switch on the back of the cradle is set to position B. 

 
Figure 4.2 

 
4. Connect USB cable (DT-380USB) to USB client port on the back of the cradle, and then 

connect the other end of the cable to PC. USB host port is used when connecting the cradle 
with other USB peripheral device. 

5. Align the USB cradle mount holes on the back of the IT-600 with the mount hooks on the 
cradle after aligning the contacts on the bottom of the IT-600 with the power contacts of the 
cradle. The power indicator LED on the front of the cradle will light in green if the IT-600 has 
been properly mounted. 

Set to B 
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Status of Indicator 1 on IT-600 

Orange : Charging 
Red :  Standby due to battery pack error or the surrounding temperature is out of the 

range (charging begins when the temperature returns within the range.) 
Green : Charging complete 

 
Important notes: 
• Make sure to first remove the IT-600 from the cradle when switching the selector switch on the 

cradle. 
• Never short out the power contacts of the cradle. This damages the cradle. 
• Do not subject the IT-600 and cradle to vibration or impact during communication. This results 

communication to be interrupted. 
• When mounting the IT-600, securely attach it to the mount hooks of the cradle and check that 

the power indicator LED on the front of the cradle lights green. Charging battery pack or 
carrying communication will not proceed properly if it is not mounted properly. 
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4.2 HA-D62IO 
Use the dedicated AC adaptor (AD-S42120B) for power supply to the HA-D62IO Ethernet cradle. 
Make sure to connect the AC adaptor to the Ethernet cradle before starting communication between 
the IT-600 and PC via the cradle. Follow the steps below to set power supply to the IT-600 using the 
dedicated AC adaptor. 
 
1. Plug the AC adaptor into the AC adaptor jack on the back of the Ethernet cradle. 

 
Figure 4.3 

 
2. After connecting the AC adaptor to the power cable, plug the plug of the power cable into an 

electrical outlet. 

 
Figure 4.4 
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3. Set the selector switch on the back of the Ethernet cradle to the port that will be used. Set the 

switch to “LAN” to use the LAN port or to “USB” to use the USB port. 

 
Figure 4.5 

 
4. Before using the cradle ports, remove the caps from the ports. When using a LAN, connect one 

end of the LAN cable to the LAN port and the other end to the PC or hub. When using a USB 
connection, connect one end of the USB cable (DT-380USB) to the USB port and the other end 
to the computer. 

 
Figure 4.6 

 
5. Align the contacts on the underside of the IT-600 with the power supply contacts on the Ethernet 

cradle and then set the IT-600 into the cradle so that mount holes in the back of the IT-600 are 
aligned with the mount hooks on the cradle. Once the IT-600 is properly set in the cradle, the 
power LED on the front of the Ethernet cradle lights green. 

 
Figure 4.7 
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Status of Indicator 1 on IT-600 

Orange : Charging 
Red :  Standby due to battery pack error or the surrounding temperature is out of the 

range (charging begins when the temperature returns within the range.) 
Green : Charging complete 

 
Important notes: 
• Always remove the IT-600 from the Ethernet cradle before changing the LAN/USB selector 

switch setting. 
• Never short out the power contacts of the cradle. This damages the cradle. 
• Do not subject the IT-600 and cradle to vibration or impact during communication. This results 

communication to be interrupted. 
• When mounting the IT-600, securely attach it to the mount hooks of the cradle and check that 

the power indicator LED on the front of the cradle lights green. Charging battery pack or 
communication will not proceed properly if it is not mounted properly. 

• The LAN and USB connections cannot be used concurrently. 
• Always cap ports that are not being used. Using the Ethernet cradle while the ports are uncapped 

can cause damage. 
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5. Connecting the IT-600 to PC 
To make connection establishment with PC, use one of the methods, depending on the OS your PC 
runs, described below. 
 
• ActiveSync (for Windows XP or any other OS earlier) 

Use the ActiveSync to connect the IT-600 to PC if the PC runs in Windows XP or other OS 
earlier than Windows XP. The ActiveSync can be downloaded at the URL below. 
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d32
33efb4c&DisplayLang=en 

 
• Windows Mobile Device Center (for Windows Vista or later) 

Use the Windows Mobile Device Center to connect the IT-600 to PC if the PC runs in Windows 
Vista OS. The Windows Mobile Device Center (“WMDC”) can be downloaded at the URL 
below. 
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F
07AAA1914&displaylang=en 

http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=46F72DF1-E46A-4A5F-A791-09F07AAA1914&displaylang=en�


 

 30

 

5.1 ActiveSync Connection  
In nearly all cases during development work you will be communicating with the IT-600 via 
ActiveSync connection. There are many ways to connect the IT-600 to PC via ActiveSync. 
You can download ActiveSync from the following Microsoft web site: 
http://www.microsoft.com/windowsmobile/activesync/default.mspx 

http://www.microsoft.com/windowsmobile/activesync/default.mspx�
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5.2 ActiveSync Connection via USB 
If you have already installed ActiveSync and connected the IT-600 to the PC via direct USB, You 
may skip the Chapter 5.2.1. You already have the USB driver and ActiveSync in your development 
environment. 

 
 

5.2.1 Installing ActiveSync for the First Time 
1. Install ActiveSync first. Initiate the MSI file of ActiveSync. 

 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.1 

 
2. Click Next > button. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.2 
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3. Hold the installation when the menu in Figure 5.3 is displayed. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.3 
 

4. Connect the USB cable to the PC and the other end to the USB cradle and also the AC adaptor 
to the USB cradle. 

5. Put the IT-600 on the cradle and confirm that the green LED on the front of the cradle is lit. If 
not, be sure the IT-600 is positioned firmly on the cradle. 

6. When the IT-600 is mounted on the USB cradle, a dialog is displayed to prompt you to install 
the suitable driver. Download the USB driver “wceusbsh.inf” and “wceusbsh.sys” from the 
CASIO Web Site and copy to the appropriate folder. 

7. Choose No, not this time radio button in Figure 5.4 and then click Next > button. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.4 
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8. Then, choose Install from a list or specific location radio button in the menu. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.5 
 

9. Click Next > button. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.6 
 
10. Choose Windows CE USB Devices icon. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.7 
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11. Click Have Disk… button. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.8 
 

12. Click Browse… button. And choose “wceusbsh.inf” from the folder you created. 
 
 
 
 
 
 
 
 
 

Figure 5.9 
 
13. Then the installation of the driver will start. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.10 
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14. Click Continue Anyway button. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.11 
 
15. A menu might be displayed to prompt to install “wceusbsh.sys”. This happens if 

“wceusbsh.sys” is not in the same folder where “wceusbsh.inf” is located. Download this file 
from the CASIO Web Site and follow the menu and then specify the location of 
“wceusbsh.sys”. 

 
16. Now the installation of the driver is complete. 

 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.12 
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17. Now go back to the ActiveSync Installation Wizard that was left on the desktop. Click Next > 

button. 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.13 
 
18. Now the connection is being established. You can select either one according to your need. 

Then click Next > button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.14 
 
19. Now the connection is complete. You can start up eMbedded VC++ and create a program and 

deploy it to the IT-600. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.15 
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5.2.2 If ActiveSync Is Already Installed 
This is the procedure if ActiveSync is already installed in the PC. Let the PC recognizes the IT-600 
and install the driver. 
 
1. Open the pull-down menu navigating to File → Connection Settings…. See Figure 5.16. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.16 

 
2. Take out the check (pointed out by the arrow) on Allow USB connection with this 

desktop computer. USB is available. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.17
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3. On the IT-600, choose PC Connection tab. Confirm that PC Connection is set to “USB 

Default”. If not, choose USB Default and tap OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.18 
 
4. When the IT-600 is mounted on the USB Cradle, a menu to prompt to install the driver is 

displayed. Follow the same steps in Chapter 5.2.1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5.19 
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5.2.3 ActiveSync Connection via IrDA 
If the PC supports an IrDA interface, it is possible to connect the IT-600 to the PC via IrDA 
interface using ActiveSync. 
 
Follow the steps below: 
1. Choose PC Connection in the Control Panel on the IT-600. 
2. Set PC Connection to IrDA. 
3. Set the COM port of ActiveSync on the PC to the IrDA port. 
4. Place the IrDA port located on the left side of the IT-600 facing the IrDA port on the PC directly. 

Communication can be established if the distance is in the range of zero to approximately 1 m. 
In case of 4Mbps rate, the maximum distance is approximately 30 cm. 

5. From Start menu, navigate to Programs → Communication → ActiveSync and then start 
up ActiveSync. 
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5.3 USB Connection via Windows Mobile Device Center  
To establish connection via USB interface with PC runs in Windows Vista, use Windows Mobile 
Device Center (“WMDC”). The IT-600 with the factory-setting (default) does not support the 
WMDC. Follow the procedure below to change the setting. 
 
Note that the CAB file, USBClientIT600.110.CAB, must be installed in the IT-600 prior to 
establishing connection with the IT-600 via Windows Mobile Device Center. For installation 
method, refer to Chapter 6.1 “Installing CAB Files”. 
 
Procedure 
1. Close all applications running on the IT-600. 
2. Navigate to Settings → Control Panel → USB Connection. 
3. Click Connect Utility tab. 

 
Figure 5.20 
 
4. Choose Windows Mobile Device Center radio button and then click OK button. 

 
Figure 5.21 

 
5. A dialogue asking your final confirmation appears. Click YES button. 

 
Figure 5.22 
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6. The IT-600 starts up again. Mount the IT-600 on the cradle, and then follow a message appeared 

in the WMDC on the PC. 
 
Notes: 
• To resume the factory default setting, choose ActiveSync/LMWIN radio button in Step 3 on 

the previous page, and start up the IT-600 again. 
• The WMDC version 6.1 or later will support the connection establishment via USB interface. 

Any other versions of the WMDC earlier are not interoperable with Windows CE devices. 
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5.4 ActiveSync Connection via WLAN 
This operation works with ActiveSync Version 3.8 or earlier. Later versions of ActiveSync do not 
support the LAN ActiveSync setting menu and thus it is not possible for IT-600 to establish 
connection with PC via WLAN or wired LAN. 
The quickest and easiest way to establish connection between the IT-600 and PC for development 
purpose is to use IEEE802.11b/g WLAN. In this configuration, models with WLAN module 
integrated (IT-600M30R, M30CR, M30R2, M30CR2, M30R2-CN, M30CR2-CN) are required. 
Follow the steps below to establish the connection. 
 
1. Establish connection first between the IT-600 and PC using any method so far described in this 

guide for connection establishment either via IrDA or via USB cradle. With the Ethernet cradle, 
see Chapter 5.8 “ActiveSync Connection via Ethernet”. 

2. Initiate the WLAN Settings tool by navigating to Settings → Control Panel → WLAN 
Settings. 

3. Click Basic Settings tab and enter Access-Point in SSID field which you want to connect if 
you already know the SSID or the Access-Point is not broadcasting its SSID. 

4. If you wish to choose a desired Access-Point from the SSID pull-down menu, click Search 
button and initiate the NetSearch tool. It will search all Access-Points which are broadcasting 
SSID and display a list as shown in Figure 5.24. 

 
Figure 5.23 
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5. If you double tap one of the SSIDs in the list (see Figure 5.24), the SSID will be input in the 

SSID field in Basic Settings tab (see Figure 5.23) of WLANConfig (the WLAN Settings toll). 
Set up the rest of parameters as required. 
 

 
 

Figure 5.24 
 
• The listed stations can be sorted by field intensity, station name (SSID) and channel. 
• Field intensity appears in green while the station is connected. 
• Information appeared in Figure 5.24 is updated every five seconds. 
• The remote station’s WLAN icon, either IEEE802.11b or IEEE802.11g, appears at the front of 

each station name. 
• A key symbol icon appears for station that uses encrypted communication. 
 
Table 5.1 Menu configuration 

Menu Description 
Display 

List Displays remote station list. 
Details Displays screen showing information on details of remote stations. 
Options Displays screen for setting remote station parameters. 

 

Version Switches address bar display. 
 
6. Click IP Settings tab and input addresses in each field as required. 

 
Figure 5.25 
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7. On the PC, make sure that Allow network… checkbox is checked in the ActiveSync setting. 

Allow network setting is only possible for ActiveSync 3.8 or earlier version. 
8. On the IT-600, navigate to Start → Programs → Communication → LAN ActiveSync to 

initiate the connection. Ensure that Network Connection is the name of the connection method 
and that Connect to line is the name of your PC. Click Connect … button and then the 
connection should be established showing the screen in Figure 5.26. 

 
Figure 5.26 
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5.5 Bluetooth Connection 
There are many peripherals such as USB dongles and PC Cards on the market that will allow you 
to add a Bluetooth serial port to a PC. This manual only covers the IT-600 side of the connection 
and assumes that you have a suitably configured Bluetooth COM port available on the PC. Your 
PC may require a Passkey during connection; if so, you will be prompted on the IT-600 at some 
point to enter the Passkey before the connection can be completed. 

 
1. Establish connection with the PC using the cradle as described earlier in this manual. 
2. On IT-600, navigate to Start → Settings → Control Panel → Bluetooth Connection. 
3. After a few seconds, a list of detected Bluetooth devices should appear. Identify the PC amongst 

these and double click its entry in the list. 
4. A list of available services for the PC will appear. Bluetooth Serial Port should be among 

them (the exact name may vary depending on the Bluetooth hardware you are using on the PC). 
Click and hold on the serial port entry and a pop-up menu should appear with an entry called Use 
to connect for ActiveSync. Click this. The icon should change to ActiveSync icon. 

5. Click Bluetooth Serial Port (or whatever the specific item is on your PC) and the ActiveSync 
connection to the PC should be established. 

6. If you click and hold on the serial port icon in the window that displays the PC side services, you 
can choose the Add Shortcut item to create a shortcut to this connection. 

7. Click the radio icon (the blue circle) and choose Shortcut. Click and hold the shortcut you 
created in step 6 and click Auto Connection in the pop-up menu in Figure 5.27. The 
ActiveSync connection will then be launched as soon as you start the Bluetooth Connection 
utility in an access later. 

8. To disconnect the ActiveSync session it is best to double-click the connection icon in the Taskbar 
and click Disconnect. 

  
Figure 5.27 Figure 5.28 
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5.6 Accessing Shared Network Drive on Your LAN 
Assuming you have a valid network connection established, you can access shared drives on your 
PC from the File Explorer on the IT-600. The following shows the steps to initiate. 
 
1. Configure a network connection on the IT-600. 
2. Double click My Computer. 
3. Type \\xxxx\ where xxxx is the network name of the PC. 
4. A network logon dialog box will appear.  
5. Enter a valid User ID, Password and Network Domain. 
6. All shared network drives on the PC will be displayed and you will be able to copy files freely 

between them and the IT-600. 
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5.7 Direct TCP/IP Connection from Visual Studio 
If you have a network connection to the IT-600 for example via WLAN or the Ethernet cradle, then 
you can establish a direct link to the development PC without using ActiveSync.  
 
For Visual Studio .NET 2003 
You require the WindowsCE Utilities add-on pack (described in Chapter 2.3). Refer to the readme 
file supplied with the add-on pack for details on how to set up the connection. 
 
For Visual Studio 2005 
1. Download the files listed below to the IT-600. 

- Clientshutdown.exe 
- ConmanClient2.exe 
- CMAccept.exe 
- DeviceDMA.dll 
- eDbgTL.dll 
- TcpConnectionA.dll 

 
The source folder in the PC: 

C:\Program Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\armv4i 
The destination folder in the IT-600: 

\Windows 
2. Run ConmanClient2.exe on the IT-600. 
3. Set the device IP address in Visual Studio 2005.  
4. Navigate to Tools in the main menu of Visual Studio 2005 → Options… → Device Tools → 

Devices. 
5. Choose IT-600 Device in the pull-down menu of Devices: and click Properties…. 
6. Click Transport: to access Configure… and set up Device IP address as shown in Figure 

5.29. 

 
Figure 5.29 
 

7. Run CMAccept.exe on the IT-600. 
8. Navigate to Tools in the main menu of Visual Studio 2005 → Connect to Device…. 



 

 48

 
9. Choose IT-600 Device in the list of Devices: and click Connect button. The screen in Figure 

5.30 if appear indicates the success of connection establishment. 

 

Figure 5.30 
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5.8 ActiveSync Connection via Ethernet 
This operation works with ActiveSync Version 3.8 or earlier. Later versions of ActiveSync do not 
support the LAN ActiveSync setting menu and thus it is not possible to connect the IT-600 to PC via 
WLAN or wired LAN. 
 
With ActiveSync version 3.8 or earlier version, another way to establish wireless connection for 
models without the WLAN module integrated (IT-600M30, M30C, M30E2, M30C2, M30E2-CN, 
M30C2-CN) is to use the HA-D62IO Ethernet cradle that makes a high speed LAN access possible. 
Follow the steps below to establish connection between the IT-600 and PC via the Ethernet cradle. 
 
1. Establish partnership first between the IT-600 and PC using any method so far described in this 

guide (connection establishment via either IrDA, USB cradle or Ethernet cradle). 
2. Connect the dedicated AC adapter to the Ethernet cradle as described in Chapter 4.2. 
3. Connect one end of the network cable to the Ethernet cradle and the other end to the network hub. 
4. Make sure the selector switch on the back of the HA-D62IO Ethernet cradle is set to the position 

“LAN”. See Figure 5.31 below. 

 
Figure 5.31 

 
5. Navigate to Start → Setting → Control Panel → Network and Dial-up Connections.  

 
Figure 5.32

Set to LAN 
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6. The following screen will appear. Double click AX887721. 

 
Figure 5.33 

 
7. The following TCP/IP screen appears. Set all the parameters in IP Address and Name 

Servers tabs as required and then click OK button. 

  
Figure 5.34 

 
8. Once the connection is established “×” will disappear on the network icon in the Taskbar. 
9. On the PC, make sure that Allow network… checkbox is checked in the ActiveSync setting. 

10. On the IT-600, navigate to Start → Programs → Communication → LAN ActiveSync to 
initiate the connection. Make sure in the popup ActiveSync menu box that Network 
Connection is the selected connection method and Connect to: field is the name of your PC. 
Click Connect … button and then the connection should be established. 
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6. Setting Up the Development Environment 

6.1 Installing CAB Files 
1. After installing the library files, the CAB files in Table 6.1 will be installed in the folder below. 

C:\Program Files\CASIO\MBSYS\CAB 
 

Table 6.1 
Library CAB file Preinstalled 

System Library en_SystemLib.ARMV4I.CAB Yes 
Laser Scanner Library en_OBReadLib.ARMV4I.CAB Yes 
Bluetooth Library en_BluetoothLib.ARMV4I.CAB Yes 
Camera Library en_CameraLib.ARMV4I.CAB Yes 
Imager Library en_ImagerLib.ARMV4I.CAB Yes 
JPEG library enJPEG.ARMV4I.CAB Yes 
FLINK library en_Flink.ARMV4I.CAB Yes (note 2) 

Notes: 
1. The library with "Yes" in "Preinstalled" column is preinstalled in the IT-600 and in the 

Device Emulator. Thus, it is not necessary to install those libraries, unless the library has 
been updated or changed. 

2. The CAB file, en_Flink.ARMV4I.CAB, in the table does not operate for the IT-600. Use 
the FlinkLib.dll installed by default in the terminal. 

 
2. Download the CAB file in Table 6.2 from the following site. 

http://www2.casio.co.jp/system_en/pa/PADealer/  
(The site requires your user name and password. Enter your user name and password as issued by 
CASIO.) 

Table 6.2 
CAB file Description 

USBClientIT600.110.CAB USB client supported by Windows Mobile Device Center 
 
3. Copy all the CAB files (except the en_Flink.ARMV4I.CAB) in Table 6.1 and Table 6.2 to any 

folder in the IT-600 via ActiveSync. 
4. Carry out each CAB file. 
5. When the installation starts, the installation status will appear. 

http://www2.casio.co.jp/system_en/pa/PADealer/�
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6.2 eMbedded Visual C++ 4.0 
The ExportSDK for IT-600 is required to develop application software with eMbedded Visual C++ 
4.0 (see note 1). Follow the steps below to install it. 
 
1. Double click IT-600_SDK.msi file (see note 2) and follow the prompts appeared on the screen 

to install the SDK. 
2. When prompted asking you to choose either Custom or Complete installation, choose 

Complete. 
3. When the installation is complete, start up eMbedded Visual C++ 4.0. 
4. Go to Chapter 8 and follow the instructions to verify that the SDK has been installed correctly. 
 
If eMbedded C++ has been installed in your PC already, you will notice that you now have a new 
SDK and, once you choose that new SDK, a new target device (IT-600) in the comb-box menu in 
the Toolbar. Also, if you use any of the Remote Tools in eVC++ then you will find IT-600 is listed 
as a new target (for example, try the Remote Registry Editor). 
 
Notes: 
1. If eMbedded Visual C++ 4.0 is used to develop application software, be sure to install Service 

Pack 4 prior to the development. 
2. Other SDK (e.g. standard SDK etc.) released before ExportSDK for IT-600 is also operable. 
3. If IT-600_SDK is installed when standard SDK has been installed already, the following dialog 

box appears for warning. 

 
Figure 6.1 

 
4. Application software developed using MFC (Microsoft Foundation Class) for CASIO IT-10 is 

not operable on the IT-600. 
5. Any application developed not using MFC is operable on the IT-600. 
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6.3 Visual Studio 2005 
There is no actual SDK available for Visual Studio as such. However, the CASIO libraries have 
been released for VB .NET and C#. See Chapter 9 for basic usage instructions. In this chapter, the 
remote debugging procedure using the IT-600 for application development in VB .NET and C# 
environments is explained. 
 
1. Establish connection with the IT-600 via ActiveSync. 
2. Open the application project for VB .NET or C# in Visual Studio 2005. 
3. Click the button in square box drawn by red line (see Figure 6.2) to make sure that Visual Studio 

2005 has recognized the connection established with the IT-600 via ActiveSync. If it does not, 
start up ActiveSync again to establish connection. 

  
Figure 6.2 

 
4. Choose IT-600 Device (or DT-X11 Device) in the pull-down menu box in Figure 6.3. 

  
Figure 6.3 

 
5. If once the debugger has started, debugging for the application can be carried out while checking 

each operation by the application running on the IT-600. 
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6.4 Visual Studio .NET 2003 
There is no actual SDK available for Visual Studio as such. However, the CASIO libraries have 
been released for VB .NET and C#. See Chapter 9 for basic usage instructions. Microsoft has 
released an add-on for Visual Studio .NET 2003 that allows you to set the target CPU for a 
connected device (Visual Studio is unable to detect the target CPU of non-Pocket PC devices). 
Follow the steps below to install the add-on pack. 
 
1. Download “Windows CE Utilities for Visual Studio .NET 2003 Add-on Pack 1.1” from the site 

described in Chapter 2.3 “Software Required”. 
2. Establish connection via ActiveSync between the IT-600 and PC using any of the methods 

described in this guide. 
3. Navigate to Tools → Select Windows CE Device CPU. 
4. In Select the device architecture pull-down menu box, choose ARMV4I. 
5. Click Configure. 
6. Re-start Visual Studio .NET 2003. 
 
You will now, for example, be able to choose Deploy <appname> from the Build menu and your 
project will be directly deployed to the IT-600. You will now also be able to remotely debug 
applications over your ActiveSync connection. 
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7. Device Emulator 
The Device Emulator provides application developers with an environment that without having 
actual device available on hand the application developer can debug basic functions and 
performances of application and at source level. 
 
 

7.1 Software Required 
The Device Emulator requires the software(s) listed below before installing the emulator. 
 
Using Visual Studio 2008 or Visual Studio 2005 

• ActiveSync 4.2 or a later version (If required) 
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d32
33efb4c&DisplayLang=en 

• Visual Studio 2008 or Visual Studio 2005 (Required) 
• CASIO IT-600 SDK (Required) 
• Standalone Device Emulator 3.0 (Optional. See note 2.) 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4
b2f-a394-356e2c2fb114 

 
Using Visual Studio.NET 2003 

• ActiveSync 4.2 or a later version (If required) 
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d32
33efb4c&DisplayLang=en 

• Standalone Device Emulator 3.0 (If required. See notes 1 and 2.) 
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4
b2f-a394-356e2c2fb114 

• Visual Studio .NET 2003 (Required) 
• CASIO IT-600 SDK (Required) 
 
Using eMbedded Visual C++ 4.0 

• ActiveSync 4.2 or a later version (Required) 
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d32
33efb4c&DisplayLang=en 

• Standalone Device Emulator 3.0 (If required. See notes 1 and 2.) 
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4
b2f-a394-356e2c2fb114 

• Microsoft eMbedded Visual C++ 4.0 (Required) 
http://www.Microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=1DACDB3D-50
D1-41B2-A107-FA75AE960856 

• Microsoft eMbedded Visual C++ 4.0 ServicePack4 (Required) 
http://www.microsoft.com/downloads/details.aspx?familyid=4A4ED1F4-91D3-4DBE-986E-A8
12984318E5&displaylang=en 

• CASIO IT-600 SDK (Required) 

http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4b2f-a394-356e2c2fb114�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4b2f-a394-356e2c2fb114�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4b2f-a394-356e2c2fb114�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4b2f-a394-356e2c2fb114�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyID=7269173a-28bf-4cac-a682-58d3233efb4c&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4b2f-a394-356e2c2fb114�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=a6f6adaf-12e3-4b2f-a394-356e2c2fb114�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=1DACDB3D-50D1-41B2-A107-FA75AE960856�
http://www.microsoft.com/downloads/details.aspx?displaylang=en&FamilyID=1DACDB3D-50D1-41B2-A107-FA75AE960856�
http://www.microsoft.com/downloads/details.aspx?familyid=4A4ED1F4-91D3-4DBE-986E-A812984318E5&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=4A4ED1F4-91D3-4DBE-986E-A812984318E5&displaylang=en�
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Notes: 
1. The software is not required if your PC has already Visual Studio 2005 installed. 
2. To use Microsoft Device Emulator 3.0, follow the steps below. 

2-1. Install the IT-600 ExportSDK and the Device Emulator in IT-600 SDK. 
2-2. Download Microsoft Device Emulator 3.0 and install it. 
2-3. Edit the following file and save the change made. 

C:\Program Files\Windows CE Tools\wce500\IT-600\Emulation\IT-600.cdes 
 

Before you change, the default parameter in the file is described as follows. 
module=DevEmu500.exe 

 
Change the parameter to the one below. Be sure to describe the whole parameter in single one 
line. 
module=C:\Program Files\Microsoft Device Emulator\1.0\ 
DeviceEmulator.exe 

 
You can substitute Device Emulator Version 3.0 released in Visual Studio 2008 for an engine of 
Device Emulator included in a IT-600 SDK by the above-mentioned work. 
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Case of using after Windows Vista OS 

If you use OS after Windows Vista (Windows 7 or Windows Server 2008), please set device 
emulation and I/O simulator as administrator. 
Please check “Run this program as an administrator” of property from opening Explorer. 
(Ex. Execute I/O simulator in Windows Vista as administrator.) 
 

 
Figure 7.1 

 
 
These program have installed the following location as default setting. 
• Device emulator 

C:\Program Files\Microsoft Device Emulator\1.0\DeviceEmulator.exe 
• I/O simulator 

C:\Program Files\Common Files\CASIO\Emulator\DevIoSim.exe 
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7.2 Starting Up the Device Emulator 
After installing all required software described in Chapter 7.1, follow the steps below to start up the 
Device Emulator on your PC. 
 
1. Navigate to Start menu → All Programs → CASIO Device Emulator and click IT-600. 
2. Make sure that the IT-600 Device Emulator has started up on the screen. See Figure 7.2. If 

Figure 7.2 and Figure 7.3 appear on your PC, it is ready to use the emulator. 
 

Note.  
If do not appear "IT-600" in "CASIO Device Emulator", please execute "Add Device". 
If you use OS after Windows Vista, please execute "DevEmuLoader.exe" as administrator by 
referring "Case of using after Windows Vista OS" section. 

 
 C:\Program Files\Common Files\CASIO\Emulator\DevEmuLoader.exe 

 

  
Figure 7.2  IT-600 Device Emulator Figure 7.3  I/O Simulator 

 
 
Terminology of Emulator and Simulator; 
The Emulator described in this reference manual is a software that can provide performances 
immense in similarity to those performed on the actual device by imitating individual hardware 
components or protocol which can control the components by side.  
On the other hand, the Simulator is also software but logically integrates application programming 
interfaces (“API”) and minimum functions to debug the application program. From the view of 
application side, the Emulator performs in the pseudo CPU and hardware environment – 
impossible for the application to recognize whether it is in actual environment or pseudo 
environment. However, performances carried out by the Simulator are not likely to those 
performed by actual components. 
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7.3 Using the Device Emulator 

7.3.1 IT-600 Device Emulator 
The IT-600 Device Emulator emulates various operations carried out by the actual IT-600 device 
on PC’s screen such as mouse pointer by mouse, input on PC’s keyboard, displaying execution of 
operation, and operations by actual devices. Figure 7.4 shows an emulated IT-600 device on the 
screen of PC. 

 
Figure 7.4 
 
Key Input 

The emulator offers the key input capability similar to the ability that actual IT-600 device can 
perform. For instance, a key on the emulated keyboard of IT-600 on the screen (see Figure 7.4) can 
be clicked with mouse of the PC as well as key input made directly on the PC’s keyboard for input. 
 
Reading Bar Code 

The emulator enables bar codes pre-registered in the I/O Simulator (see Figure 7.3) to be input when 
clicking Trigger key on the emulated keyboard (see Figure 7.4). Note however that clicking the 
Trigger key continuously for a period of one second or longer is required. Otherwise, an incorrect 
key input may result. 
 
Sound 

The emulator offers the beep and sound capability similar to the capability that actual IT-600 device 
can output via its integrated speaker.  
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7.3.2 I/O Simulator 
The I/O Simulator simulates registration of bar codes, generation of low battery warning, detection 
of terminal being mounted on cradle.  

 
Registration of bar code symbologies 
1. Registration 

Click ADD1D or ADD2D button (drawn by red line in Figure 7.4) to change the screen into the 
bar code registration mode. 

 
Figure 7.5 
 
2. Bar code registration 

Choose a bar code symbology in the Code Type pull-down menu that you wish to register in 
the I/O Simulator. 

Figure 7.6 
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3. Registration of bar code and note 

Enter a bar code data in the Code field (see Figure 7.7) that you wish to register and a note 
about the bar code in the Note field if necessary. Click OK button to complete the bar code 
registration. 

  
Figure 7.7 

 
4. Completion of registration 

After completion of the bar codes registration, the screen in Figure 7.8 shows a list of bar codes 
that have been registered in the I/O Simulator. Prior to debugging with the Device 
Emulator, make sure that you register all bar codes you use in debugging. 

 
Figure 7.8
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5. Editing registered bar code content 

Highlight a bar code in the list of registered bar codes (see Figure 7.8) you wish to edit and 
click Edit button. Figure 7.8 appears for editing the bar code and its information.  

 
Figure 7.9 
 
6. Deleting registered bar code content 

Highlight a bar code in the list of registered bar codes (see Figure 7.8) you wish to delete and 
click Del button. Dialogue screen appears to confirm with you. If it is okay to delete, click Yes 
button, otherwise click No button. 

 
Figure 7.10 
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Detection of Terminal in Cradle and Low Battery Warning 
If you check in the I/O Box and Low Battery boxes of STATE SETTING field (see Figure 7.11), 
the simulator simulates the respective performances. 

 
Figure 7.11 
 
I/O Box 

If this box is checked, notification is issued informing the connection between the IT-600 Device 
Emulator and cradle is being established. The notification can be utilized by the application. 
 
Low Battery 

If this box is checked, notification informing the generation of low battery warning is issued when 
the battery pack capacity becomes low. The icon in the toolbar in the emulated screen appears either. 
The notification can be utilized for the application to recognize that the generation of low battery 
warning has been issued. 
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Indications 
The I/O Simulator expresses a change of state that occurred in the IT-600 Device Emulator. 
 
• LED 

When the IT-600 Device Emulator turns on the LED, the LED icon (LED2) in the I/O 
Simulator also turns on. See Figure 7.11. 

 
• Vibration 

When the IT-600 Device Emulator turns on the vibration, the Vibration icon in the I/O 
Simulator also turns on. See Figure 7.11. 

 
Figure 7.12 
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7.3.3 Connecting via ActiveSync 
If debugging with the Device Emulator is carried out in either eMbedded Visual C++ 4.0 or 
Visual Studio 2008 or Visual Studio 2005, or transmission/reception of a file with the Device 
Emulator is carried out, ActiveSync must be used. 
 
Setting ActiveSync 

1. Start up ActiveSync and then navigate to File → Connection Settings …. 

  
Figure 7.13 

 
2. In Connection Settings screen, check in the Allow connections to one of the 

following box and choose DMA in the pull-down menu. See Figure 7.14. 

  
Figure 7.14
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Connection via ActiveSync 
The ways to establish connection of the Device Emulator via ActiveSync are; 
- Using Visual Studio 2008 or Visual Studio 2005 
- Using Standalone Device Emulator 3.0 (if Visual Studio 2008 or Visual Studio 2005 is not 

available.) 
 
1. Start up the Device Emulator by referring to Chapter 7.2 “Starting Up the Device Emulator”. 
2. Start up Visual Studio 2008 or Visual Studio 2005, and then navigate Tools → Device 

Emulator Manager. 
3. If Visual Studio 2008 or Visual Studio 2005 is not available on hand, start up the Standalone 

Device Emulator 3.0. 
C:\Program Files\Microsoft Device Emulator\1.0\dvcemumanager.exe 

4. Right-click IT-600 Emulator in Available Emulators list and then choose Cradle in the 
popup menu. See Figure 7.15. 

 
Figure 7.15 
 
5. Make sure ActiveSync has started up and the  icon in the status bar appears. See the emulated 

screen of IT-600 in Figure 7.16. The icon indicates that the connection via ActiveSync has been 
established. 

  
Figure 7.16 Figure 7.17 
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7.4 Debugging Application 
This chapter describes how to debug your application using the Device Emulator. Before starting 
“Build”, establish connection between the IT-600 and your PC via ActiveSync by referring to 
Chapter 7.3 “Using the Device Emulator”. 
For the order of developing application, refer to Chapters 8 “eMbedded Visual C++” and 9 “Visual 
Studio”. 
 
 

7.4.1 Setting Build Configuration 
When using Visual Studio 2008 or Visual Studio 2005 

Choose Debug in the Solution Configurations pull-down menu in Visual Studio 2008 or Visual 
Studio 2005 and IT-600 Emulator in the target device pull-down menu. See Figure 7.17. 

 
Figure 7.18 

 
When using eMbedded Visual C++ 4.0 

Choose IT-600 in the Active WCE Configuration in pull-down menu in eMbedded Visual C++ 4.0, 
Win32 (WCE ARMV4I) Debug in the Active Configuration pull-down menu, and IT-600 Device 
in the Default Device pull-down menu. 

 

Figure 7.19 
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7.4.2 Debugging Application 
Basic Debug Operation 
The debug operation used for the Device Emulator in both Visual Studio 2005 and eMbedded 
Visual C++ 4.0 is the same with ordinary debug operation. 
 
Debugging with the Device Emulator 
With the Device Emulator, it is possible to set a brake point in source code of application program 
for step-by-step debug method. 
 
In case of using Visual Studio 2008 or Visual Studio 2005 

Navigate to Debug → Start Debugging to start up debugging. 

  
Figure 7.20 

 
Similar to ordinary debugging operation with actual IT-600 device used, the Device Emulator 
allows break point setting (drawn by red circle in Figure 7.21) in the source code and step-by-step 
debug method. 

 
Figure 7.21 
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In case of using eMbedded Visual C++ 4.0 

1. Establish connection between the Device Emulator and PC via ActiveSync before starting 
debugging in eMbedded Visual C++ 4.0. For establishing connection via ActiveSync, refer to 
Chapter 7.3.3 “Connecting via ActiveSync”. 

2. Navigate to Build in the menu bar → Start Debug → Go to start up debugging. 

  
Figure 7.22 
 
3. Similar to ordinary debugging operation with actual IT-600 device used, the Device Emulator 

allows break point setting (drawn by red circle in Figure 7.23) in the source code and step-by-step 
debug method. 

 
Figure 7.23 
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8. eMbedded Visual C++ 

8.1 Building Simple eVC++ 4.0 Test Program 
1. On the PC, initiate eVC++ 4.0. 
2. Navigate to File → New in the File menu. 

 
Figure 8.1 
 
3. Highlight WCE Application in Projects tab. See Figure 8.1. 
4. In Location: field, navigate to the folder where you want to create the new project. 
5. In Project name: field, type in the name of the project. 
6. In CPUs: pull-down menu, check Win32 (WCE ARMV4I).  

Note: 
You can also check Win32(WCE emulator) and Win32 (WCE x86). 

 
7. In the next dialog, leave A typical “Hello World!” application checked. Click Finish and 

then click OK button. 
8. Below the Toolbar you will see a line of pull-down menu lists. Look for the one that indicates 

STANDARDSDK and choose IT-600 SDK in the list. The right most pull-down menu list will 
change to either IT-600 Device or IT-600 Emulator. 

 
Figure 8.2
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9. Initiate an ActiveSync connection using one of the methods described in this manual. 

10. Choose Rebuild All from Build menu (or use the appropriate icon on the Toolbar). 
11. The program will be built and automatically downloaded to the IT-600. By default, the program 

will be copied to the root folder on the terminal. Run the program to check that the process was 
successful. 

 
You are now ready to begin development work with the IT-600. The full operation of eVC++ 4.0 
and the use of features such as remote debugging are beyond the scope of this manual. See the 
Chapter 10 “Resources” for details on where to start if you are new to eMbedded C++ development. 
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8.2 Using CASIO Libraries from eVC++ 4.0 
The IT-600 SDK provides the libraries for C++ applications. See Chapter 1.2 “Library 
Configuration” for the list of libraries provided. 
 
Each library in the table (see Table 1.2) consists of a header file, a dll and a library file. The dlls are 
built into the ROM of the IT-600 and you do not need to download. The following is a simple 
example using one of the System Library functions in the simplest kind of WindowsCE program. 
The screen will flip 180° each time this program is carried out. 
 
1. Make sure all the “.h” files for the CASIO libraries are installed in \Program Files\Windows 

CE Tools\wce500\IT-600\include\ARMV4I\  
(This is the default installation location but yours will be different if you installed the SDK to 
other location). 

2. Make sure all the “.lib” files for the CASIO libraries have been installed in \Program 
Files\Windows CE Tools\wce500\IT-600\lib\ARMV4I\. 

3. In eVC++ 4.0, choose New from the File menu. 
4. Highlight WCE Application. Choose a location and a name for the project and make sure the 

ARMV4I option is checked. Click Next > button. 
5. On the next dialog click A simple Windows CE application option. Click Finish and then 

click OK button. 
6. Make sure the IT-600 is the selected SDK and target device in the pull-down list boxes. 
7. Click ClassView tab in Solution Explorer and expand classes fully until you can see 

WinMain() class. Double click it. 
8. At the forefront of the source file, under #include stdafx.h code add the following code. 
 

#include SystemLib.h 
#include SystemLibdef.h 

 
9. Move to the line // TO DO: Place code here and add the following code. 
 

int  result; 
 
result = SysGet180Rotate(); 
if( result == FALSE ) 
{ 
 SysSet180Rotate( TRUE ); 
} 
else 
{ 
 SysSet180Rotate( FALSE ); 
} 

 
10. On the Project menu, navigate to Add To Project → Files… 
11. Change Files of type: pull-down menu list to Library files (.lib). 
12. Navigate to the folder where the CASIO library files are stored (see step no. 2 in the previous 

page), highlight SystemLib file and click OK button. 
13. Initiate ActiveSync to establish connection between the IT-600 and the PC. 
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14. Choose Build All from Build menu. The project will be built and copied to the IT-600. 
15. Check the operation by running the program. You should find that each time the program is 

carried out, the screen flips 180°. 
 
You should now be able to use the CASIO System library in your C++ applications. See the System 
Library Manual for full detail of all the functions. 
 
You can also use the CASIO samples as described in Chapter 1.4. 
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9. Visual Studio 
This chapter explains the development procedure of the application that uses the following 
development platforms. 

- Visual Studio 2008 
- Visual Studio 2005 
- Visual Studio .Net 2003 

 
• VCC++ application development for the IT-600 using Visual Studio 2005 is not supported. 

Always use eMbedded Visual C++ for VCC++ application development. 
• The functions of the Common Device Control Library which control various individual devices 

integrated in the IT-600 have different name spaces and names from those available for the 
previous CASIO handheld terminals. They are not compatible with the ones in the previous 
CASIO library. 

• VB .NET application or C# application developed with Visual Studio .NET 2003, but not with 
the CASIO dedicated libraries will run on the IT-600. 

• Application developed with any functions of CASIO dedicated library must be rewritten by 
replacing the dedicated functions with the appropriate functions from the Common Device 
Control Library. 

• New application for the IT-600 can be developed using either VB .NET or C# in Visual 
Studio .NET 2003 or Visual Studio 2005. 

• It is recommended that Visual Studio .NET 2003 is used to modify applications developed for 
other handheld terminals for the IT-600. 

• However, if Visual Studio 2005 is used to make modification, the solution/project of Visual 
Studio .NET 2003 is automatically changed by Visual Studio 2005. This may result in different 
configuration of the output folder according to the parameter settings for the project file. 
Process your application development with care focusing to this change. 
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9.1 Using CASIO .NET Libraries from VB .NET 
The IT-600 SDK provides the libraries for VB applications. See Chapter 1.2 “Library 
Configuration” for the list of libraries provided. 
 
This chapter explains how to create and start up a simple test program using one of the System 
functions. The test program flashes the LED in red for 5 seconds. 
 
1. Create a new VB .NET Smart Device Application in Visual Studio .NET. 
2. Click Add Reference… from Project menu. 
3. Click Browse and navigate to the folder where you have stored the CASIO .NET library files. 

Highlight SystemLibNet.dll and click Open. Click OK button. 

 
Figure 9.1 
 
4. Add a button to the form, and double click it. 
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5. In the event function for the button click, add the following code. 
 

Dim result As Int32 
Dim msg As String 
 
result = Calib.SystemLibNet.Api.SysSetLED( _ 
            Calib.SystemLibNet.Def.LED_RED, 5, 8, 8) 
 
'.NET vales of “true” and “false” are “-1” and “0” respectively. 
If result = -1 Then 
    result = Calib.SystemLibNet.Api.SysGetLED() 
    Select Case (result And &HF) 
        Case Calib.SystemLibNet.Def.LED_OFF 
            msg = "LED_OFF" 
        Case Calib.SystemLibNet.Def.LED_RED 
            msg = "LED_RED" 
        Case Calib.SystemLibNet.Def.LED_GREEN 
            msg = "LED_GREEN" 
        Case Calib.SystemLibNet.Def.LED_ORANGE 
            msg = "LED_ORANGE" 
        Case Else 
            msg = "LED_UNKNOWN" 
    End Select 
    MessageBox.Show(msg, "LED") 
End If 

 
Note:  
If you type this code manually you should see the IntelliSense offer you suitable options as 
appropriate. If you do not, make sure you review steps 1 to 5 to make sure you have added the 
reference correctly. 

 
6. Initiate ActiveSync to establish connection between the IT-600 and PC. 
7. Choose Deploy <name of project> on Build menu. 
8. The project will be built and copied to the IT-600. By default, it will be copied to \Program 

Files\<name of project> folder. SystemLibNet.dll will be deployed to the same folder. 
9. Check that the program works correctly on the IT-600. 
 
You can also use the CASIO samples as described in Chapter 1.4. 
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9.2 Using CASIO .NET Libraries from C# 
The IT-600 SDK provides the libraries for C# applications. See Chapter 1.2 “Library Configuration” 
for the list of libraries provided. 
 
This chapter explains how to create and start up a simple test program using one of the System 
functions. The test program flashes the LED in red for 5 seconds. 
 
1. Create a new C# Smart Device Application in Visual Studio .NET. 
2. Click Add Reference… from Project menu. 
3. Click Browse and navigate to the folder where you have stored the CASIO .NET library files. 

Highlight SystemLibNet.dll and click Open. Click OK button. 

 
Figure 9.2 
 
4. At the top of your source file add the following code. 
 

Using Calib; 
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5. Add a button to your form, double click it and add the following code: 
 

Int32 result = new Int32(); 
string msg; 
 
result = SystemLibNet.Api.SysSetLED(SystemLibNet.Def.LED_RED, 5, 
8, 8); 
 
// .Net values “true” and “false” are “-1” and “0” respectively. 
if(result == -1) 
{ 
    result = SystemLibNet.Api.SysGetLED(); 
    switch(result & 0x0000000F)  
    { 
        case SystemLibNet.Def.LED_OFF: 
            msg = "LED_OFF"; 
            break; 
        case SystemLibNet.Def.LED_RED: 
            msg = "LED_RED"; 
            break; 
        case SystemLibNet.Def.LED_GREEN: 
            msg = "LED_GREEN"; 
            break; 
        case SystemLibNet.Def.LED_ORANGE: 
            msg = "LED_ORANGE"; 
            break; 
        default: 
            msg = "LED_UNKNOWN"; 
            break; 
    } 
    MessageBox.Show( msg, "LED"); 
} 

 
Note: 
If you add this code manually you should see the IntelliSense offer you suitable options as 
appropriate. If you do not see this, then review steps 2 to 4 in the previous page to make sure you 
have not made a mistake. 

 
6. Initiate ActiveSync to establish connection between the IT-600 and PC. 
7. Choose Deploy <name of project> on Build menu. 
8. The project will be built and copied to the IT-600. By default, it will be copied to \Program 

Files\<name of project> folder. SystemLibNet.dll will be deployed to the same folder. 
9. Check that the program works correctly on the device. 
 
You can also use the CASIO samples as described in Chapter 1.4. 
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9.3 Using CASIO Libraries from C++ 
This chapter explains how to create and start up a simple test program using one of the System 
functions. The test program flashes the LED in red for 5 seconds. 
 
The intention of this chapter is just to check that the development environment is set up correctly. 
See Chapters 6.3 and 6.4 for information on how to set up a connection between the IT-600 and 
Visual Studio. You must install Visual Studio 2005 Service Pack 1 from Microsoft. 
 
Before following the steps below, you will need to add the paths for the CASIO header and library 
files to Visual Studio 2008 or Visual Studio 2005. Choose Tools-Options-Projects and 
Solutions-VC++ Directories. Change the “Platform” to “IT-600” and add the path to the CASIO 
header and library files to the respective lists for “Include files” and “Library files”. 
 
1. First, create Win32 Smart Device Project with its device name DeviceApp for Visual C++ 

in Visual Studio 2008 or Visual  Studio 2005. 
2. Choose default platform in the Selected SDKs field in the Platforms of Win32 Smart Device 

Project Wizard and click < button. 

 
Figure 9.3 

 
3. Choose IT-600 in the Installed SDKs field and click > button. 

 
Figure 9.4 
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4. Click Next > button while IT-600 is kept being highlighted in the Selected SDKs field. 

 
Figure 9.5 

 
5. Choose Console Application for the Application type in the Application Settings menu, and 

click Finish button. 
6. In Solution Explorer, click DeviceApp.cpp and then append the source code below subsequent 

to “#include <commctrl.h>”. 
 

#include <SystemLib.h> 
#if !defined(_countof) 
#define _countof(_Array) (sizeof(_Array) / sizeof(_Array[0])) 
#endif 
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7. Append the source code below in the main function of DeviceApp.cpp. 
 

    DWORD result; 
    TCHAR msg[16]; 
 
    result = SysSetLED(LED_RED, 5, 8, 8); 
 
    if(result == TRUE) 
    { 
        result = SysGetLED(); 
        switch(result & 0x0000000F) { 
        case LED_OFF: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_OFF") ); 
            break; 
        case LED_RED: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_RED") ); 
            break; 
        case LED_GREEN: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_GREEN") ); 
            break; 
        case LED_ORANGE: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_ORANGE") ); 
            break; 
        default: 
            wcscpy_s( msg, _countof(msg), TEXT("LED_UNKNOWN") ); 
            break; 
        } 
        MessageBox(NULL, msg, TEXT("LED"), MB_OK); 
    } 
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8. Choose Properties in the Project of Visual Studio 2008 or Visual Studio 2005, and navigate to 

Configuration Properties → Linker → Input → Additional Dependencies and then 
append SystemLib.lib (see red circle). 

 

Figure 9.6 
 

9. Choose IT-600 Device for the Target Device to establish connection with the PC. 
10. Choose Debug in Visual Studio 2008 or Visual Studio 2005 and then click either Start 

Debugging or Start Without Debugging. 
11. The project will be built and copied to the “\Program Files\<name of project>” folder (by default) 

in the IT-600. 
12. Check that the program runs correctly on the IT-600. 
 
You can also use the CASIO samples as described in Chapter 1.4. 
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10. Resources 
Microsoft’s own http://msdn.microsoft.com/mobility/ is an extremely comprehensive resource for 
programmers targeting WindowsCE .NET based devices. It includes links to most other useful web 
based resources. You will find detailed Software and Library manuals on 
http://world.casio.com/system/pa. 

http://world.casio.com/system/pa�


 

 84

 

11. Troubleshooting 
Connections from Visual Studio .NET 2003 to Pocket PC and WindowsCE .NET devices can be 
difficult to establish. This appears to be a Visual Studio issue and is not limited to only CASIO 
terminals. The good news is that once you have established an initial connection, you are unlikely to 
experience problems thereafter. Here are some things to try if you find that you have this problem: 
 
• Start with an empty, out of the box device. If necessary, hard reset the IT-600 by holding down 

the Power key, the CLR key and poking the reset hole on the back of the terminal. Follow the 
on-screen instructions to complete the hard reset. If in doubt, see the User Guide. Please note 
that this will erase any data currently held in RAM on the terminal. 

• In Visual Studio, select Tools-Options-Device Tools-Devices. Set the Platform to 
WindowsCE. Make sure that Transport is set to TCP Connect Transport. Note that once 
you have successfully connected you can use the Save as option to rename the connection 
type to IT-600 - This makes it clearer which device you are deploying to in future. 

• Follow the instructions in the Windows CE Utilities for Visual Studio 2003 readme file in 
order to identify the processor type of the connected device. For IT-600, select ARMV4I. The 
default location for the utilities is...\Program Files\Microsoft Visual Studio .NET 
2003\CompactFrameworkSDK\WinCE Utilities. 

• Establish the ActiveSync connection, and then initiate Visual Studio. Try to deploy a solution. If 
it fails, exit Visual Studio, re-start it and try to deploy again. 

• Try running the ProxyPorts.reg file that comes with the Windows CE Utilities for Visual 
Studio 2003 from Microsoft. See the readme file that comes with the utilities for details about 
this. After doing this, follow the steps above. 

• Follow the other advice in the WinCE Utilities readme file. 
• Run the Visual Studio .NET 2003 setup again. Uninstall Smart Device Programmability (by 

removing the check) and then re-install Smart Device Programmability. 
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